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1. QGIS INSTALLEREN, PROGRAMMA SETTINGS AANPASSEN (BIJV. TAALINSTELLING)

(2 Untitled Project - QGIS
Project Edit View Layer [EEslield Plugins Vector Raster Database Web Progessing Help

N B @ User Profiles g\ &Ca &.;a @ U_—Elg M e 6

24 Style Manager..
Ha

= abe| fand] @b (abe|

ﬂ % v; ”b e &% Custom Projections... P o “ " 8

|PDOK Locatieserver zoek DDD Keyboard Shortcuts...

Browser

ZRTY®TO

% Interface Customization...

“  Recent Projects

En daarna “Override system locale” aanvinken en kies je gewenste interface taal. Je moet QGIS opnieuw
opstarten om de taalwijziging te kunnen zien.

(2 Options | General X

'L\\:, Override system locale

User Interface Translation ‘ == American English

Locale (numbers, date and currency formats) ‘ Dutch Netherlands (nl_NL)

Show group (thousand) separator
MNote: Enabling / changing override on locale requires an application restart
Detected active locale on your system: nl_NL
Sample date: 13-03-19 money: 1000,00 € int: 1000 float: 1000,00




2. PLUGINS MENU; PDOK PLUGIN TOEVOEGEN

(&) Untitled Project - QGIS
Project Edit View Layer Settings [l

NEERRE Y |
ROV AW /.
@ |PDOK Locatieserver zoek | "

Vector Raster Database Web Processing Help

Manage and Install Plugins...

. Python Console Cirl+Alt=P

Pdok Services Plugin

Daarna, typ PDOK in de zoekbalk hier:

(2 Plugins | All (302) / X
& A [a |

= & AcATaMa “| Al Plugins
F 1 Installed . 5
4 Advanced Line Editor
% Notinstalled % agknow for QGIS On the left you see the list of all plugins available for your
. ot installed

X QGIS, both installed and available for download. Some
4 AmigoCloud plugins come with your QGIS installation while most of
# Animate OSM them are made available via the plugin repositories.

»
" New You can tem I bl disabl lugi
porarily enable or disable a plugin. To enable
2 & Another DXF Importer / DXF25hape Co or disable a plugin, click its checkbox or double-click its
3% Install from ZIP # Append Features to Layer name...

& Area Along Vector Plugins showing in red are not loaded because there is a
problem. They are also listed on the 'Invalid' tab. Click on
& arrayPlus the plugin name to see more details, or to reinstall or

4 Asistente LADM_COL uninstall this plugin.

# Attribute based clustering

4 Attribute painter

% AttributeAssignment

4 AustrianElevation

# autoSaver

& AwaP

# Azimuth and Distance Calculator
# Azimuth and Distance Plugin

| | Upgrade All Uninstall Plugin Reinstall Plugin

Close | |

Help

Klik op “PDOK services plugin” en daarna op “Install plugin”

(@ Plugins | All (302) %

| Q. PDOK a|

# PDOK Locatieserver Locator Filter

e PDOK services plugin ®

Rledzaled Plugin to easily load the available dutch
PDOK (Publieke Dienstverlening Op de
"’, New Kaart) services. Currently only in dutch.

Plugin to easily load the available dutch PDOK (Publieke
Dienstverlening Op de Kaart) services. Currently only in

Install from ZIP

Settings e A A R -
ﬁ 9 WITIWITIr 46 rating vote(s), 85968 downloads

Tags pdok,services nederland,ows

More info homepage bug tracker code

repository
Author Richard Duivenvoorde

3.4.4

Available version

4
Upgrade All | Install plugin ‘

| Close || Help

Andere handige plugins om te installeren zijn:
- SRTM Downloader (hoogtedata)
- INSPIRE Nederland plugin voor QGIS (data vanuit de Europse INSPIRE dataset)



3. WEBLINKS NAAR DATASETS TOEVOEGEN IN BROWSERMENU; WFS, WMS/WMTS

BRONNEN.

Klik met rechtermuisknop op de juiste categorie in het Browser-paneel (bijv: WMS/WMTS, XYZ Tiles,

WEFS of ArcGisFeatureServer) en klik op “New Connection...”

Als je geen Browser-paneel ziet, moet je het terugzetten via “View->Panels->Browser”.

LeTvTHe

hd y Favorites |
b [ C\Users\brw\Helicon Opleidingen\Team MB Team Milieu - D¢
[&] Home

o

e GeoPackage

,’ Spatialite

@ rostals

P mssaL

@ Oracle

£ pe2

» & XYZ Tiles 5 New Connection... —

€ wes
» 7 WES
» ) OWS

- v

@ ArcGisMapServer

Browser

Kies een naam voor je nieuwe koppeling en plak de URL in het URL veld (in principe hoef je verder

niks in te vullen of aan te vinken:

() Create a New WMS/WMTS Connection X

Connection Details

Name | v |
URL | - |

Authentication

Configurations | Basic

Choose or create an authentication configuration
| No authentication v | | == |[:-E]|

Configurations store encrypted credentials in the QGIS
authentication database.

WMS/WMTS Options

Referer | |

DFE-Mode | all - |

Ignore GetMap/GetTile URI reported in capabilities
Ignore GetFeatureInfo URI reported in capabilities
Ignore axis orientation (WMS 1.3/WMTS)

Invert axis orientation

Smooth pixmap transform

OK Cancel | | Help

Hier een aantal handige links:

WMS/WMTS:

Brabant Bodemwijzer:

https://atlas.brabant.nl/arcgis/services/b

Brabant Wateratlas:

https://atlas.brabant.nl/arcgis/services/BWA_opper

totaal v2/MapServer/WMSServer

/MapServer/WMSServer

XYZ Tiles:

Google Satellite:
https://mt1.google.com/vt/lyrs=s&x={x}&y={y}&z={z}
Google Hybrid:
https://mt1.google.com/vt/lyrs=y&x={x}&y={y}&z={z
Google Road:

https://mt1.google.com/vt/lyrs=m&x={x}&y={y}&z={z

WES:

Brabant Cultuurhistorie:
http://atlas.brabant.nl/ArcGIS/services/pgr t01 cultuur/MapServer/WFSServer
Nationaal Georegister:

http://geodata.nationaalgeoregister.nl/bag/wfs

ArcGisFeatureServer:
Atlas Brabant:

https://atlas.brabant.nl/arcgis/rest/services




4. KAARTLAAG TOEVOEGEN VANUIT BESTAANDE DATASET (EXCELTABEL, CSV

BESTAND)

Zorg dat je je gegevens in de vorm van een .csv bestand hebt en klik hier om te importeren:

(2 Untitled Project - QGIS
Project Edit View [ENEM Settings Plugins Vector Raster Database Web Processing Help

D _rj &qga‘ta Source Manager Ctrl+L J/D\ [B U:E []‘_Fl e i N \.
=h

-HEE

q @ Ve ’ Create Layer > N S
il -l Vi, Add Vector Layer.. Ctrl+Shiftsy [
BSW;EIY T 0 Embed Layers and Groups.. 'u Add Raster Layer... Ctrl+Shift+R
e
Add from Layer Definition File...
» @ Oracle
» a DB2 Pl Copy Style .u Add PostGIS Layers... Ctrl+Shift+D
v @ WMS/WMTS | [ Paste Style £7 Add SpatiaLite Layer.. Crl+shiftel [ 5 "
b =€ Brabant Boi . Copy Layer ’_, Add MSS5QL Spatial Layer... Ctrl+Shift+M
b =C Brabant Wa . B
- @ XVZ Tiles F Paste Layer/Group @, Add DB2 Spatial Layer... Ctrl+Shift+2
% OpenStreet Open Attribute Table = .L: Add Oracle Spatial Layer... Ctrl+Shift+O .
@ wcs Taggle Editing Add/Edit Virtual Layer...
v &) wrs B Save Layer Edits @ Add WMS/WMTS Layer... Ctrl+Shift+W

b =C Brabant Cul
» =¢ Brabant Wa f Current Edits @ Add ArcGIS MapServer Layer...

Brabant Wa Save As.. % Add WCS Layer... P

b () OWS ] Add WFS Layer...
@ ArcGisMapServ
& ArcGisFeatureS L1 Remove Layer/Group

=

Save As Layer Definition File...

Ctrl+D %_’a Add ArcGIS FeatureServer Layer..

Kies je bestand via de ... knop.
Als je gegevens in het csv bestand ni
puntkomma, moet je dit aangeven.

met een komma zijn gescheiden, maar bijv. met een

Check of QGIS de juiste gegevens vindt voor de X en

Geef aan in welk codrdinatensysteem jouw gegevens staanl

Q Data Source Manager | Delimited Text / / X
B erowser

. g Vector Layer name | | Encoding | UTF-8

File name ‘

¢ Raster w File Format

. es -
==y Mesh () CSV (comma separated values) Tab Space

, Delimited Text ) Regular expression delimiter Semicolon Others ‘
. " "
GeoPackage (@ Custom delimiters UL | =R ‘

Spatialite w Record and Fields Options

ostgreSQl N . i
PostgreSQL Number of header lines to discard | 0 ecimal separator is comma

MSSQL | First record has field names rim fields

) Oracle v Detect field types Discard empty fields

D82 DB2 ¥ Geometry Definition

Virtual Layer Point coordinates X field |/ |4

i
() well known text (WKT) ¥ fiald

&3 wmsmwmTs
: () No geametry (attribute only table) DMS coordinates
£ wes

Geometry CRS | EPS&‘BZE - WGS 84

g WFS

- ¥ Layer Settings

,!: ArcGIS Map Server
v | Use spatial index Use subset index ngh file

¢ ArcGIS Feature Server

= Sample Data
s GeoNode e

Please select an input file




5. KAARTLAAG MAKEN OM ZELF IN TE TEKENEN: PUNTEN, LIJNEN OF VLAKKEN

(@ *Untitled Project - QGIS
Project Edit View Settings Plugins Vector Raster Database Web

D 1__‘ E I g Data Source Manager Ctri+L

Mesh  Progessing Help
: ' 1L -

te Layer

Q @ \/: £ AddLayer
: ‘ Embed Layers and Groups... ﬂ New SpatiaLite Layer...
a PDOK Locatiesar Add from Layer Definition File... 8 New Temporary Scratch Layer...
Browser . [} Copy Style {2 New Virtual Layer...

aanpassen|dus mag je nu laten zoals het is.

() New GeoPackage Layer 7\ X

3
(il
5
%
5

B<SB<8S8S

Fields List

Name Type Length

Remove Feld

OK Cancel Help




Zorg dat je jouw laag in de juiste CRS maakt! Voor Nederland werken we vaak met Amersfoort
coordinaten. Staat de juiste CRS niet in het drop down menuutje, klik dan op de knop er rechts naast
om de CRS te zoeken:

() New GeoPackage Layer X
Database
Table name
Geometry type | | Peint v
Include Z dimension Include M values
| £PSG26992 - Amersfoort / RD New 3
Project CRS: EPSG28992 - Amensfoort / RD New
Default CRS: EPSG:4326 - WGS 84
7
EPSG-3E5T - WGS 84 / Preudo-Mercator
EPSG:TA1S - Amersfoont / RD New
Type IGNF-LAMB2 - Lambert Il
o EPSG5628 - RGFE3 / Lamben-33
Add to Feids List
Fields List
Name Type Length

Met de teken tools kun je je punten, lijnen of vormen (polygonen) gaan intekenen. Dit kan pas nadat
je de @ functie aangezet hebt.

() *Untitled Project - QGIS
Project Edit View

DEBRR

Layer Settings Plugins Vector Raster Database Web Processing Help

ML, ARDPPRALAEED

M@GVoAawm Sy B - c/x-Z T =<0 B o = @ F

Nu komen de tools beschikbaar (bij lijnen of polygonen ziet het teken tooltje er net iets anders uit).

(2 *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

NEBEERERRY UL, RPPLLALLROMR
BV.Zw PJ B SR~ 020 B 60 =9

"o Va 2

Dit is de teken tool voor punten: (voor lijnen: en voor polygonen: )

Bij het tekenen van lijnen en polygonen klik je net zo lang tot je tevreden bent met je lijn/figuur, en
sluit je je lijn/figuur af met een rechtermuis-klik. Bij elk nieuw punt, lijn of vlak vraagt QGIS om een id
in te vullen. Je mag je zelf kiezen wat je hier invult.

fq—(

Met deze tool kun je nog wijzigingen doen: (deze tool heet ‘Vertex-tool’ vanaf QGIS3)
(als je goed kijkt zie je een hamertje+schroevendraaiertje bij een punt op een lijn)




6. ATTRIBUTENTABEL BEKIJKEN EN AANPASSEN (+FORMULES VOOR X/Y/OPPERVLAK)

Om de attributentabel te openen die bij een kaartlaag hoort, klik je met de rechtermuisknop op de
laag in het Lagenpaneel en kies je voor “Open Attribute Table”. Je kunt ook op deze knop klikken

boven in de balk: of op F6 drukken (selecteer wel eerst de juiste laag).
Layers =]

o 3 & T &~ &0

Cultuurhistorische laadechannan
~ |v| & OpenStreetMap p Zoom to Layer
%) Zoom to Selection

Y Show in Overview
Show Feature Count
Copy Layer
Rename Layer

B Duplicate Layer

Q Remove Layer...

B Open Attribute Table

Filter...

Set Layer Scale Visibility...
Set CRS »

Export 4

C, Type to locate (Ctrl+K

In de attributentabel zie je alle gegevens die horen bij de elementen op de kaart. Als je een
onderdeel aanklikt in de tabel met rechtermuisknop kun je dat specifieke onderdeel snel vinden. Kies
bijvoorbeeld voor “Flash Feature” en je ziet het gekozen element opflitsen op de kaart. Als je de
kaart niet goed in beeld hebt moet je de tabel iets kleiner maken.

7 Cultuurhistorisc... Maaskant met Beerse en Baardwijkse Ov... LSBO Beerse en Baar... Maaskant, Lang...

6 Cultuurhistorisc... |Na‘[ionaa| Land==k Ly SGW Groene Woud Meierij, Kempen
Select All

15 Cultuurhistorisc...  Nationaal Park Copy Cell Content Loonse en Drun... Meijerij, Langstr...

4 Cultuurhistorisc... Oude zandland Zoom to Feature Oud zandlandsc... Kempen

A A Pan to Feature A
18 Cultuurhistorisc... Landgoederen Landgoederenz... Baronie

| 7 show Al Features,, Open Form

Je kunt in de tabel ook kolommen toevoegen, zodat je meer gegevens kunt koppelen aan de
bestaande elementen. Daarvoor gebruik je deze tools (boven in de tabel-balk):

Nieuwe kolom toevoegen

5]

Kolom(men) verwijderen



Deze tools zijn alleen beschikbaar als je je laag in ‘Edit’ modus hebt staan ( / ). Sommige
lagen/tabellen kunnen niet worden bewerkt. Bijvoorbeeld tabellen uit csv-bestanden niet. Wil je
deze toch bewerken, dan moet je de laag eerst exporteren als nieuwe shapefile-laag:

Set Layer Scale Visibility...
Set CRS

e DB2
o

4

Layers
o (3 = 3

[ ted
/' dasscii

. Buffered
@ dassen-bodem

Export

Styles »

Properties...

@ Save Vector Layer as...

Format ESRI Shapefile v

File name

Layer name

CRS EPSG:28992 - Amersfoort / RD New - %

@

Met deze knop (“Field Calculator”), die er uit ziet als een ouderwets telraam, kun je kolommen
toevoegen met gegevens die je door QGIS laat berekenen. Denk aan de X of Y codrdinaten, of de
oppervlakte van een shapefile element.

Als je op de knop klikt krijg je dit scherm te zien.

Hier geef je aan dat je een nieuwe kolom wilt toevoegen
Hier geef je de naam van de kolom op (in dit voorbeeld heb ik “X” gekoz
Hier vul je de rekenformule in waarmee QGIS gegevens gaat berek

(@ Field Calculator

selected features

Only upd

v Create a new field

Create virtual field

Output field name ‘X

Output field type  Whole number (integer)

+ Precision

Output field length | 10

Expression Function Edi

Q Search... Show Help

group aggregates

a

row_number
Aggregates
Arrays

Calor
Conditionals
Conversions
Date and Time
Fields and Values
Fuzzy Matching
General
Geometry

Map Layers
Maps

Math

Operators
Rasters -

Contains functions which aggregate values
over layers and fields.

Output preview: 129791

Cancel




7. LABELS TOEVOEGEN AAN PUNTEN OP KAART OP BASIS VAN GEGEVENS UIT
ATTRIBUTENTABEL

In de eigenschappen van een laag kun je aangeven dat je labels wilt toevoegen aan kaartelementen.
Rechtsklikken, dan “Properties...” of dubbelklikken op de laag.

o (] & T &~ & O Export

V| [#] test2 Styles
@ dassen-bodem

Properties...
Monumentale bomen

. Cultuurhistorische_landschappen
~ W = OpenStreetMap

Kies in het Eigenschappen menu voor ‘Labels’ en verander “No labels” in “Single labels”.

) Layer Properties -

Mo labels

(@ Rule-based labeling
g Blocking

T ST

Lorem Ipsum

Lorem Ipsum

e Text Tt
2*F Formatting Forit

M5 Shell Dig 2
abe Guffer

Vervolgens geef je in het veld daaronder aan welke kolom van de attributentabel je als labels wilt
gebruiken:

1 Q Layer Properties - Monumentale_bomen | Labels >

‘@ Single labels b

Label with | abc ADRES

w Text5 123 opccTm

Lorem abc GEMEENTE

abc paaTs
abc oNpERDEEL

Lorem Ips abe ADRES

sbe Text
2 Forn| abe pLanTIAGR BOOMSOORT
wbe Fuffd

1.2 oMTREK

W Back
J Shad1.2 HOOGTE

‘:: Plact abe wancTer
R

- T

10



8. KLEUREN KAARTELEMENTEN WIJZIGEN OP BASIS VAN CATEGORIEEN UIT

ATTRIBUTENTABEL

Om de kleuren van je kaartelementen te veranderen ga je ook naar de eigenschappen van de laag, en
kies je voor “Symbology”. Verander dan “Single Symbol” naar “Categorized” zodat je de kleuren
afhankelijk kunt maken van waarden uit de attributentabel.

= OCraduated
B Rule-based

@ Paint displacement
% point chuster

*  Heatmap

&

Hier heb ik een kaart van monumentale bomen, waarbij ik heb gekozen om de kleur van de punten
afhankelijk te maken van de boomsoort. Je kiest dan ‘Boomsoort’ en klikt op “Classify”.

@ Layer Prop _bomen | 5 s |
= Categonized - |
1 Inform Columa  abe BUOMSDURT -]}
3 () symbol @ Change...
& symbology Cokor ramp Random colars |'
&3 Labels Symbal ™ Value Legend L
. v e Acer pl.. Acer plat Schwedler”
" v e acerpl..  Acer platanoides
- e Acer pa..  Acer pseudoplLeopaldin’
3D ] Ager ps.. Acer pseudoplatanus
ey v e Ager sa.. Acer sacch Laciniatum Wieri
h urce F v e Ager sa.. Acer saccharinum
orm | Acer ga... Acer saccharum
o 8 mescd,.  Aesculus hipp Baumannii®
(AR Apscul.  Assculus hippocastanum
Jairs Vv e sescul..  Aesculus x camea
. v e Allanth...  Arlanthus altissima
ﬁ LA Al g, Alnus glutinosa
v e Carpin...  Carpinus betulus
p v e Castan..  Castanea sativa
o o catalp...  Catalpa bignonioides
- ¥ ®  Cadus.. Cedruslibani
o o Cedris .. Ledrus hiban 'Glauca®
v most v o chama... Chamaecypans lawsoniand
v e Cratee...  Crataegus x lavalle
L Deverse...  Diverse soarten
l 3 v e Eagus = Fagus sylv. Pendula’
v Faqus =.. Fagus urpurea’
™ Depende v e Fagus &... ~Remillyensis”
. e Fagus &.. i
W e Fagus 5., Fagus Sylvatica (5)
) v e ~. Fravanus excPendula®
Ve .. Fraxinus excelsior -
R Digitizing | cssy [[&B||= | peletesn Advanced T
 Layer Rendering
stle - K Cancel Apply Help

11



9. PRINTOPMAAK MAKEN VAN KAART ZODAT DEZE NETJES IN VERSLAG KAN WORDEN

TOEGEVOEGD

Zie voor tips en trucs met de Printopmaak van QGIS deze oefening op qggistutorials.com:

http://www.qgistutorials.com/en/docs/making a map.html

12



10. LAAG TOEVOEGEN MET DE OFFICIELE KM-HOKKEN (AMERSFOORT COORDINATEN)

Als je graag de officiéle km-hokken van het Rijksdriehoeksstelsel op de kaart wilt zien, kun je deze
toevoegen in de Print layout (zie ook onderdeel 9 hiervoor).

Selecteer de kaart waarover je de km-hokken wilt trekken in het items paneel.

G e = a »
Liysee 82 Yoow poly Addmes M Semeg
BEdRAER 9 4ine @
2APHAC @ H
a e i et
P
5"

[ -

R
(F = i
3| - |
=% }
w3 he
= |
[-SFE |
B 1 |
Ay 5 |
2 .
ot i
AL r .
R [

e :

i [ |
ofe B

: s
F |
E |
8 |
-

In het menu daaronder kies je het tabblad ‘Item Properties’, en vervolgens open je het gedeelte bij
‘Grids’. :Elik op de + en pas eventueel de naam ‘Grid 1’ aan. Klik vervolgens op ‘Modify Grid...’

= w Grids

b
i = A v &+ o= A

Grid 1

Driw *Amersfocnooordnatin” grd Modiy Grd

W/ Drawe "Grid 1" grid Mod#y Grid

Pas de instellingen van het Grid als volgt aan:

CRS = EPSG: 28992 (=Amersfoortcoérdinaten)

Interval unit = Map unit (dan pakt QGIS als maat de maten uit het CRS, in dit geval meters)
Interval = 1000 (voor zowel X als Y; 1000 meter is 1 km dus komt er elke km een lijn)

Itern Properties EI
w Appearance
Grid type Sobd -
CRS EPSG:26932
Interval units Map unit v
X 1000,000000000000 a .:
Interval z
Y IOOD,DDOODDOODOOD € | 3 |
X 0,000000000000 I:
Offset :
\_' 0,000000000000 ::
Line style -
Blend mode Normal -
13




Bij een net Grid horen ook de coérdinaten op je afbeelding. Plaats daarom ook een vinkje bij ‘Draw
coordinates’ (nog steeds in de Map Grid Properties).

Item Properties

¥  Draw Coordinates

Format Decimal v
Left Show all v
Outside frame -
Horizontal -
Right Show all -

Meestal is het voldoende om bij de km-hokken alleen de eerste 3 cijfers van elk coordinaat weer te geven.
Standaard plaatst QGIS een Amerfoort codrdinaat als bijvoorbeeld (146,398) langs jouw kaart als 146000.000
en 398000.000.

Je kunt die .000 op het eind al kwijt raken door de ‘Coordinate precision’ op O te zetten:

N Horizontal v
Font Fortt -
T &
Distance to map frame 1,00 mm a :3
Coordinate precision 0 '_C

Maar nog mooier is om het ‘Format’ aan te passen naar een ‘Custom’ waarde, en via de € deze formule te
gebruiken. De formule zegt eigenlijk tegen QGIS “geef alleen de eerste (linker) 3 cijfersvan de coérdinaat
waarde weer”.

w v Draw Coordinates

¥

Format Decimal

Decimal with suffix

Left
Degree, minute

Degree, minute with suffix
Degree, minute aligned
Right Degree, minute, secon

Degree, minute, second with suffix

Degree, minute, second aligned

() Expression Based Annotation %

Expression Function Editor

Q Sea Show Help

=|l+|l-fl/0=N~Iln Current grid annotation value.
rid_axis

left{@grid_number,3) g g e Current value: 0
to.dm

14



11. (SPECIAAL VOOR POELENONDERZOEK) BUFFERS BEREKENEN RONDOM SHAPEFILES

Je kunt QGIS een zone laten aangeven rondom een bestaande shapefile. Bij het poelenonderzoek is
dit een handige functie om te bepalen welke poelen nog binnen 400 meter van elkaar liggen (de
maximale afstand waarbij amfibieén nog kunnen migreren van poel naar poel).

Zorg dat je eerst een Shapefile laag hebt getekend met jouw poelen daarin. Let er op dat deze
Shapefile laag in de juiste CRS (projectie) staat! Voor dit voorbeeld is dat Amersfoort co6rdinaten.

Kies dan onder “Vector” voor “Geoprocessing-gereedschap” en dan “Buffer...”

(G ~Unanied Project - OIS

Project it Wew Layer Setongs Bhgins
IRERRE O%4
"ev.se B L/ B

Baster [atabase Yeb Mesn Progeming  Help

Ggometne-gereedichapmen " O

Anatyse-gereedschap * @ Comex Hut
Bl%R-F% RREEUWR|  Dewunsgementpereetschan  +|  Difterence.
[ o cocsiereer et (%] Qecerzoeis-gersedschup +| @ Dasolve
[ r | ; Intersection
o Sym il Dt .
S | YTt al erence.
Farvorites. L )| WP union
v [7] C4Users\brwh Helcon Dpleicingen!Team MB Team Mileu - D | (000, | P Eliminase Sedected Polypons.
* [ Home [ -
SL) oV 8-\
@ GeoPackage 2
# Spatialite Ly g A
Postlas b
P nssan
@ Dracke P
& oaz \ -
* B WMSWMTS. e L ~
@ vz T g /
¥ OperSerian
@ wes !
) A W - -

L -\\
-
Vg =
ol N
p 2 0,
. = -
e « GRhailine
v F

Q Buffer

Parameters | L

Input layer / /

| (=) Poelen [EPS[%/.zsggz]

Selected feafures only
Distance

Buffer
o This algorithm computes a buffer arega for
‘ | 2 | all the features in an input layer, usijig a

fixed or dynamic distance.

The segments parameter controls/the
number of line segments to use t
approximate a quarter circle whén

| 200,000000 /

a |=| ‘ meters

- ‘ e' creating rounded offsets.

Segments The end cap style parameter gontrols how
line endings are handled in the buffer.
[5 | 4 %]
The join style parameter spgcifies whether
End cap style round, miter or beveled joirls should be
|Rmmd - | used when offsetting corngrs in a line.
. The miter limit parametef is only
J I
oin style applicable for miter join /styles, and
| Round - | controls the maximum distance from the
o offset curve to use when creating a
Miter limit mitered join.
| 2,000000 %]

Dissolve result
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De nieuw gemaakte bufferlaag wordt bovenaan in de laagvolgorde geplaatst, maar het is iets
overzichtelijker om hem onder de oorspronkelijke poelen te plaatsen. Verschuif de laag daarvoor iets
naar onder in je laagvolgorde. Let op dat deze laag in eerste instantie nog een tijdelijke laag is. Dat
zie je aan dit icoontje in het lagenpaneel:

Dubbelklik op het icoontje om de laag permanent te maken en als bestand op te slaan.

[ | Buffered

Tenslotte is het de moeite waard om de kleur en transparantie van de buffers wat aan te passen (via
de laag-eigenschappen). Als twee bufferzones overlappen/elkaar raken dan liggen de bijbehorende
poelen binnen 400 meter van elkaar. En wil je het nog een beetje anders weergeven, kies dan eens in
je nieuwe buffer-laag voor Vector -> Geo-processing gereedschap -> Dissolve.
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